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WHAT IS MICROSOFT EXCEL?

An overview from Microsoft (http://office.microsoft.com/en-us/excel/HA101656321033.aspx - Excel Home Page i Product
Overview link) describes Excel as a powerful tool you can use to create and format spreadsheets, and analyze and share
information to make more informed decisions.

What does that mean and why do you need spreadsheets? Simply put, spreadsheets allow you to organize data i once that

data is organized the possibilities are endless. Formatting data in a spreadsheet allows you to apply fun tools like sorting and
formulas. If the data needs to be presented or analyzed, it can also be transformed into tables and charts. For example, | can
quickly take some numbers given to me in a Word Document (in a table) 1 copy and paste the table into Excel and turn it into
any number of charts or tables:

A B C D E F G H 1 J K L
1 |# of Hours Read # of Children Percent
2 |5 hours 876 72% Number of Children
10 hours 749 62%
3 m 5 hours
20 hours 550 45% W10 hours
4
201 5
30 hours 384 32% " 20heur
5 M 30 hours
*50 hours 102 8% W50 hours
6 W *0Over 50 hours
*Qver 50 hours 84 7% 100 hours and over
7
"00 hours and over 22 2%
# of Children
5 1000
900
9 | Total # of hours read: 31,6951 800
10 | Top # of hours read by one child was 240. o
11 ™ 30 hours was the top prize level in 09 500
12 400
300
13 200 B # of Children
14 100
0
15
; Shours 10 20 30 *50  *QOwver *100
16 hours  hours hours  hours 50 hours
17 hours  and
18 aver



http://office.microsoft.com/en-us/excel/HA101656321033.aspx

Excel can be used to create financial documents such as budgets or
revenue and expense reports (including checkbook registers). They can
be used for timesheets or calendars i and many more uses! Just take a
look at some of the Template options in Excel >

WHERE CAN YOU FIND HELP FOR MICROSOFT EXCEL?

Do not be afraid to |l ook online and al so use the
look up things!

Microsoft Website

The Microsoft website has a lot of good information i including tutorials and training information. You can
search by product to find relevant information. Visit http://www.microsoft.com and take a look around. For
example i notice the Training and Events section below:

Your potential. Our passion.®

: | | | | | 1
Windows 1 Office | All Products iBuy Now | Downloads &Trials ' Partner & Customer Solutions | Security & Updatgg Training & Events | Support | Abou

r B TraJTraining & Events i
Experience this i‘n Silverlight ; *  Learning Tools
E‘v Download the free plug-in > ; / *  Events & Webcasts

*  Windows Training & Events

*  Office Online Training & Demos

*  Developer Training, Careers &
Events

*  IT Pro Training & Certification

Try Microsoft Office 2007
free for 60 days

Agendas
Budgets
Calendars
Expense reports
Faxes
Farms
Inventaories
Invaices
Labels
Lists
MMemas
Plans
Planners
Receipts
Repaorts
Schedules
Statements
Stationery

Time sheets

hel



Take advantage of
Free self-paced training courses
for Office programs!

» Training Home
Training Courses by
Version

# Office 2007 courses
» Office 2003 courses

Other Training
Resources

» Office Training
Roadmaps

= Office 2007 User
Interface Guides

» Downlosdable training
presentations

» Office Demos

#» Office Webcasts and
Podcasts

= Training Site Help

Other Learning
Resources

= Microsoft Learning

» Microsoft Office
Certification

= Third-Party Courses

Support and
Feedback

= Product Support

Home = Help and How-to

Free self-paced training courses for Office programs I

Use audio and video with Office Communicator

Hear and see your contacts with Microsoft Office Communicator 2007,
Make audio and video calls, learn how to escalate an IM session to an
audio or video call, and learn how Communicator 2007 integrates with
Microsoft Office Outlook 2003 and later.

Office 2007 training courses

Browse by program

Access 2007
Communicator 2007
Ewcel 2007

Live Meeting 2007
OneMote 2007
Outlook 2007

PowerPoint 2007
Project 2007

Publizher 2007
SharePoint Server 2007
Visio 2007

Word 2007

PerformancePoint Server 2007

Office 2003 training courses

Browse by program

Access 2003

PowerPoint 2003




Microsoft Excel Website

You can also visit the Microsoft Excel Home Page i this pages has some great information available click-by-click for things

suchasin Pr oduct

Oviexcel2 @vd &Amai ni ngo

http://office.microsoft.com/en-us/excel/default.aspx

Clay wicrosore .
.a.Office Online
Home ] Products | Help and

How-to  Downloads | ClipArt  Templates

]

Microsoft Office Livg

Search

‘ ‘ ™ Microsoft Office Excel ‘ . r p gfeft;: gf
S i
\v ’ Search Excel 2007 Search O ‘ " | /14 Powered b

Microsoft Office Excel

Home = Products

» Excel Home
Product Information

» Overview

»Top Reasons to Try
» See Itin Action

» Pricing Information

» Free 60-day Trial
» Buy Now
Help and How-to

Excel 2007

» Excel 2007 Help
» Excel 2003 Help
» Excel 2002 Help
» Excel 2000 Help

Choose your version ‘ Free 60-day trial «[Ma  Buy Excel 2007

» Excel Web Access )‘=,’ Download a free trial of Office g-m Retail $229/$109 or save with
Training Professional. » Try now v an Office suite. » Buy now
»Excel 2003 Training =

» Excel 2007 Demos | |{_ “ Which Omcle suitle is right for you?

See what's new »

You can al so
microsoft.com to get to the Excel Home
Page.

Take a look and find out for yourself!

In addition to the online help mentioned on
page 5, you can also access help in the
Microsoft Excel application by clicking on
or pressing the F1 (Function 1)
key.

See the on page 8.

s Exaaloc ho nii Mi

cr


http://office.microsoft.com/en-us/excel/default.aspx

NAVIGATING EXCEL IFE‘E
Microsao

Office Ex:]%
2007

TIP:You may al so click one iitwileurntbloe afnsde It ehetnd stihmp | yh @rrtecsist A
AReturno i f you haodickihga hard ti me doubl e

If you have a Desktop Shortcut for Microsoft Excel, double-click to open it.

You can also access it from your Start Menu (if you do not see it, click on All Programs).

Excel Terminology and Where to Click

1. Microsoft Excel Help (as mentioned on previous page)

(B "IH . B&a :l‘—. Bookl - Microsoft Excel - = X
) b4

Home Insert Page Layout Farmula a Review View Add-Ins Acrobat 1 ﬂ'@) - =
— == = ) || 5= Insert ~ xE - :
2 [alibri 1 -] = EI|%9/"| =1 Wrap Text General - r ‘d |_‘ﬂ'
— =] B T Delete ~ || (8]~
dB I U ~|[E-|| I A~|||E = =||2= 25| | fadMerge & Center - ||| $ - % 9 || %8 ;%8| | Conditional Format  Cell eran Sort & Find &
F = = = == = = Ll il Formatting = as Table = Styles ~ || [ Format ~ 27 Filter~ Select -
e s Font P Alignment IFi Number ] Styles Cells Editing
| Al -~ | ™
A B C D E F G H | 1 K L Il N 0] P L
1

2. Office Button
3. Quick Access Toolbar



= 4

e = Ak Bookl - Microsoft Excel =
il / =
_,/J Hame Insert Page Layout Farmulas Data Review View Add-Ins Acrobat h 5 W - 3 X
== = | | g=Insert - E - :
J & Calitri 11 <A = E'.-‘.‘rap Text General = :h:l :L"jﬁ .;d = W &a
F == = I Delete ~ E -
Paste 'p I U - |- A~ |E = = Merge & Center = | | $ = % 9 [[%3 ;%8||/| Conditional Format  Cell - Sort & Find &
- 7 — = = L Formatting = as Table = Styles = || fa-] Format = 2~ Filter~ Select~
Clipboa... ™ Font IF] Alignment IF] Number (F] Styles Cells Editing
G w 4 -
A B C D E F G H | | K L M N 0 P

4. Ribbons
5. (Ribbon) Tabs

10



The Office Button

a2
o

By clicking on the Office Button a menu or list of commands displays. This menu deals with files and documents:

Save to Office

Frint

Prepare

Send

Publish

LClose

Office Live F

s Book2 - Micro
Add-In]
Recent Documents
3
F¥ 2010 Expenses.xlsx 1=l
Jack Assignment 200 5. Kirkwood.xlsx 1=l ([ater ~ |||
Software Inventory.xls = &
Time Sheet.xls [ ||p—
purchase alert sample.xls 1=l
= (I H

U T T Sy | WY T [ [

Database Subscription list.xls

| 2] Excel Options | |X Exit Excel

TIP: For users of Excel 2003, the Excel Options button
on the bottom replaces the Options command from the
Tools Menu.

11



The Quick Access Toolbar

This tool bar all ows you

many options available from the Office Button menu
such as Open or Save. To add buttons to this

v toolbar, click on the (dropdown arrow) to see
available buttons.

Click on the buttontoadd i a X

will indicate the button is on the toolbar.

’E{l id - == |
i

__/ Home Insert Page LEA[ktDmizeQuickﬂccessTnulbar

n Colors = J Ly
— Fonts = ]

Themes Margins Orient
- Effects = - -

Themes

Al [

=
[a=]
]

I

(W T T Y T S P A T Y

—
=

M ew

CJpen

Save

E-mail

Cuick Print
Print Preview
Spelling

Unda

Redo

Sort Ascending
Sart Descending

More Commands...

Show Below the Ribbon

Minimize the Ribbon

12



The Ribbon Tabs

Each Ribbon is represented by a Tab. The picture below shows the Home Ribbon:

N 2 (A ) 5 Bookl - Microsoft Excel =0 X
o/ =
—-/ Hame Insert Page Layout Farmulas Data Eeview View Add-Ins Acrobat h W - 7 X
3 b Calibri 11 A AT ==||®-| | 5Wrap Text General - E:I“:_SI _L_.‘j,'ﬂl‘ __-I 5= Insert @ x- ‘%F }a
=3 A — == = I Delete ~ -_I_]' 5
Paste B J U~ - - ~||||&= = =||2= 2= || ad Merge & Center - - B y |[=:0 .00 Conditional Format Cell Lot ~ Sort & Find &
> - — = = e ¥ e e Formatting = as Table = Styles = || (== Format = || &2~ Fijter = Select =
Clipboa... ™ Font IF] Alignment IF] Number L] Styles Cells Editing
| Al - fe | ‘ 1 ¥
A B C D E F G H ] K L M N 0 ) L
1
2
3
a
5
The following Ribbons are available:
1. Home
¢ Basic text formatting T Font Style, Size, Bold, Underlining, etc.
2. Insert

¢ Allows you to add things such as Shapes, Tables, Pictures, Charts, Symbols, etc.
3. Page Layout

e Used to set up Margins, Columns, Gridlines, Headings, etc.
4. Formulas

e Allows you to insert Functions such as Auto Sum, Date & Time, Error Checking, etc.
5. Data

e Used to Import Date, Sort, Filter, etc.

13




6. Review

e Review functions i Spellchecker, Thesaurus, Track Changes, etc.
7. View

Allows you to select Document Views, Zoom, Show Gridlines, etc.
8. Ot her so
[ ]

Context-Sensitive Tabs (i.e. Picture or Table Tools)
Add-Ins or Additional Software Tools (i.e. Brother printer commands or Adobe Acrobat)

FINDING YOUR WAY AROUND RIBBONS

You can change Ribbons by clicking on t Pkoenul&siRibiooonds Tab. The

-’Eﬁ\ H h;‘, 'ﬁ _:,. = Bonlk? - bdirroenft Fyeal —
—-’/I Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat 'L?) - 8 X
ﬁ E AutoSum ~ i Logical = : & Reference ~ =) Define Name ~ £3A Trace Precedents ] Show Formulas j el 3

E— Recently Used = iA Text - i_g Math & Trig = £ Use in Formula I=':’ETrace Dependents ‘@} Error Checking = = I—J‘
Insert :_ . . Mame Watch Caleulation '-:.J
Function L'-Tj Financial = E‘fr Date & Time ~ [E[J Maore Functions = Manager B Create from Selection <{« Remove Arrows ~ () Evaluate Formula | window || Options ~
Function Library Defined Mames Formula Auditing Calculation

| Al - f ¥

it B C D E G H I 1 K L M M 0 2 A
o
L]

2

3

a

14



The commands (ortasks)ona r i bbon are organized by group. I n the picture
,-”i:!n H9-C-Z&Q )+ Book? - Microsoft Excel
Ll |
- Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat
2 Cut —il=
= d Cu Calibri -1 -lA A= = E||$?,»v| = Wrap Text General - i
~— 53 Copy - =
Paste === = - A -l= = === s=|| & i = - 0 s ||=:2 00| Conditi
5 Format painter ||| B 4 B || <[ S || = =(|F E|| Emegeacenter - |§ - % 2 |[%§ 5| Condil
Clipboard ] Font P Alignment ] Number ]
: D) | 9 ES& )
If a group has the following symbol a3
. . . - Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat
in the lower right-hand corner, click on —— |
— u o e =y — - = . 7
|t for more OptlonS. _j B Copy Calilari 11 A A ||| = E||@'_| = Wrap Text General i_é'l % (
Pafte F Format Painter /B I U -~ = = 5| EMerge aCenter - ||| § - % o || 5 5% 'EO"I,:%'E?”“;'Y as‘;;”b"la:'
Clipboard (F] Font Alignment IFi Number IFi
Al - £ |
A B C
1 ! Formau Calls
2 S
3 Mumber | Alignme: |Border Fill Protection
a Font: Font style: Size:
5 Calibri Regular 11
5 " Cambriz (Headings) ~ 3 -~
Calibri Eod _: Ttalic g =
7 T A770-Deco Bold 10 -
g T A780-Deco Bold Italic
Hr A550-Deca 12
el T Aargau bt 14 v
10 Underline: Color:
11 |None v| |_ v| [#] tiormal font
12 Effects Preview
13 [ strikethrough
14 [ superscript AaBbCcYyZz
15 [ subscript
16
17
g This is a TrueType font. The same font will be used on both your printer and your
J'B SCreen.
10
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THE VIEW

Document Views

Several view types are availablei t he mo st
preference for one or the other after you look at

c o mmo nNoraalee ®@agedBieakiPieyiewdi you will have a

them. ¢ Tg\-._ = 59 -
. . —-/I H Insert P Layout F | Dat Revi View Add-]
Normal is usually the Default; if you want to = = - e e ) "W
change the view from Normal, simply click on one EITE NN v FormuaBar Q) L
. . : V| Gridlines ¥ Headings |  * =
of the other views. If yOU are in the Full Screen Marmal| Page Page Ereak CL_!st-:um Full - Zoom 100% 4
Reading view you will not see the Ribbons and Layout  Freview © Views Screen S —
. i . Workbook Views Show/Hide Zoom
Groups. To return to the Normal view, right-click ™ ]
on the blue bar above the Column Headings and
click on Restore - E c : i © .
' o
2
[= Booka - Microsoft Excel k
A B C D G H J L M N 0 P

1

2 — Minimize

3

a

5 ¥ Close Alt+H4
G

7

16




Zooming

Often times you will want to increase or decrease the view size of the document on your screen. From the View tab you can
choose 100% or click on the Zoon button for more options. You can also switch from a One Page view to a Two Page view.

Formulas Data Review View Add-Ins Al

Ruler ¥ Formula Bar L{ |_]
0] |

¥ Gridlines ¥ Headings | % 7
Zoom 100% Zoomto

Message Bar Selection
Show,/Hide Zoom

If you are not on the View tab and you want to zoom in our out, you can use the slide on the bottom 1 click and drag the U
to the right to enlarge your document (zoom), or to the left to decrease. You can also click on the

or to move the slide.

=/~ Excel Home Page - Mi...

17



USING EXCEL

Cursors, Cells, Rows & Columns

Cursor shape

You wi || still see the Anormal 6 arrow when navi ga

Cursor shape

The vertical line cursor is also in Excel when you click in a cell (or the formula bar) to type

9P Cursor shape The cursor takes on a plus sign (block/fat) when hovering around spreadsheet
+ l-griee)georr]?ill The cursor takes this shape when you drag the outside of a cell to extend a series or fill (drag inside to clear)

<y~ | Todrag data

The cursor takes this shape when you drag the outside of a cell and move contents

0o H 9 - =1 IR Boo

2

—-/I Home Insert Page Layout Farmulas Data Review View Add-Ins Acrobat

3 d Cut Calibri 11 | A A = =8| | SiwWrap Text General

o 53 Copy = B

- - - - == = || Ext= == - A 0 o] - - @ -
aj : # Format Painter bl H -~ A = B =||#F 25| | I Merge & Center $ h Enterlng Text or Data
Clipboard F] Font F] Alignment F] Mumb
E8 - |
A B c D E - G H | Place cursor in selected cell to

1 A enter/type text or data. You may use the
2  CELL N Tab key or the Arrow keys to navigate
3 N\ cells. The Enter key will move your
: | | | ROW | | | | L cursor.

. Cells are referred to by what row

7 and what column they are in T

s 4 | _I when you select a cell you will see

9 the Row and Column headings
10 CIOLUMN highlighted. Se e AE80 t o
11 18
12




FORMATTING

Text/Data

With Excel, formatting is by cell, so it is often most helpful to enter your data and then change the text, size, color, etc. Just as
in Word you will select what you want to change, but in Excel you will select the cell(s) which contain the text to be formatted.
Once selected, format away!

Cells
Cells can also be formatted to accompany a specific type of data. Youcanright-c| i ck on t he cell and cl i ck
.0 or you can use the buttons available on the Ri bbssenththesuch a

picture on the next page.

Formatting might include wrapping text in the cell, formatting a date (9/9/09 vs. 9/09/2009 vs. 9-Sept-09, etc.), aligning the text
within a cell, adding a fill color, etc.

19



|;| H2-¢0-Z&RQ )+ - :
Home Insert Page Layout Farmulas Data Review View Add-Ins Acrobat
B fhoCul Calibri - - A K| | = =|®r| | Siwrep Text General - *ﬂ %;.'
P_t e EoRy Sy A = 5 8 C d;; I F
aste = = = =l === ; > - 8 onditiona arm
- - Format Painter [ B =] E | a- |EEFFE e MeraE A center = | | %o % s Formatting ~ as Tab
Clipboard (] Font || (F] ' Alignment ' ] ' Number ‘ IFi '
¥ . i =
A1 - £ |
A B C D E F G H | J K L Y
o
2 Format Cells
3
4 | Alignment Font Border Fill Protection m
2 Cateqary: #
i A
6 Sample :
- Mumber
Currency .* cut
B Accounting General format cells have no specific number format. ) -
Date 53 | Copy
3 Time .
10 Percentage @ Paste
11 ;E?;r?i?gc Paste Special..,
12 Text Insert...
Special
13 Custom Delete...
14 Clear Contents
L Filter
16
Sort
17
18 A Insert Comment
19 % Format Cells...
20 Pick From Drop-down List..,
21 Mame a Range...
22 % Hyperlink...
23
OK, Cancel @ Erother P-touch
o J | l
23

20




Rows/Columns

Rows and columns can be adjusted (height and width) by clicking and dragging on the gridlines of the headings. If you want to
make a row taller click on the gridline of the Numbered Row Headings and drag; click on the gridlines of the Lettered Column
Headings and drag to make a column wider. You can also right-click on the Row(s) or Column(s) and choose Row Height or
Column Width and adjust the value:

| Right Click

N

G ' H

¥

g Cut
53 | Copy
[ Paste
Paste Special...
Insert
Delete
Clear Contents
ff‘ Format Cells...
LColumn Width...,
Hide
Unhide

@ Erother P-touch

TIP: On a worksheet, you can specify a column width of O
(zero) to 255. This value represents the number of
characters that can be displayed in a cell that is formatted
with the standard font (standard font: The default text font
for worksheets. The standard font determines the default
font for the Normal cell style.). The default column width is
8.43 characters. If a column has a width of O (zero), the
column is hidden.

You can specify a row height of O (zero) to 409. This
value represents the height measurement in points (1
point equals approximately 1/72 inch or 0.035 cm). The
default row height is 12.75 points (approximately 1/6 inch
or 0.4 cm). If a row has a height of 0 (zero), the row is
hidden.

If you are working in Page Layout view (View tab,

Workbook Views group, Page Layout button), you can specify a column width or row height in inches. In this view, inches are

the measurement unit by default, but you can change the measurement unit to centimeters or millimeters (Microsoft Office

Button, Excel Options, Advanced category). ~Excel Help

21
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WORKSHEETS AND WORKBOOKS

In Excel, the data is organized on a worksheet (spreadsheet); you can have multiple worksheets which then make up a

workbook. Whether you have a single worksheet, or a workbook with several worksheets, it is one file (.xIs or .xIsx).

When you open/create a new spreadsheet the workbook contains 3 sheets by default (this can be changed in the Excel

Options in the Office Button menu). These sheets are represented by tables on the bottom of the page and are named
Sheetl, Sheet2, and Sheet3. These sheets can be formatted for ease in navigating i such as changing the sheet name or

even the tab color.

i

23 24
24 2
i 26

M4 r M| Sheatl -~ Sheet2

Sheet3 . ¥1

4 4 » M| July 2009 . August 2009 September 2009 October 2009

Movemb

Heady

Ready

30
31

mSheetl Sheet2

You can navigate between sheets
by clicking on a sheet name or using
the arrows to the left of the first
sheet; click on the arrows will move

)

to the left or right sheet: 3 4 The

arrows with the vertical lines will take you to the first sheet or the

last sheet.

Right-clicking on the sheet tabs will give you options to insert,
rename, etc. If you choose to insert a sheet, it will be inserted to
the left of the sheet you right-clicked on. You can also click on the

Al nsert Wor ks heet 0-sidesobtheflast talm d

14
15 Insert...
16 Delete
17 Eename
18 Move or Copy...
19 Gl View Code
20 &)y | Protect Sheet...
el Tab Colar r
22
Hide
23
24
55 | | Right Click Select All Sheets
LR L eetl - Sheef2 " Sheefl _Sheet4®
Ready Iﬁf P e ‘E

or

L imne llglil

22




SAVING

When saving, you can click on the Office Button and you will see Save and Save As options. Save As offers you the ability to
choose what type of workbook you would like to save it as.

New

/ Open

Save
Save As
_, Cpen fraom Office Live »
Save to Office Live L4
Print k
Prepare 3
Send [ 2
Publish [ 3

Close

o K

T

S

o—’lﬁ

Save a copy of the document

l':‘ Excel Workbook &
[H]

Excel Macro-Enabled Workbook

Excel Workbook
= . XIsx file
extension in

Save the file as an Excel Waorkbook
[
W1 Save the workbook in the XML-bas

macro-enabled file format.

Excel Binary Workbook

optimized for fast loading and savi

Excel 97-2003 Workbook
Save a copy of the workbook that i
compatible with Excel 97-2003,

)

[ |

_| Adobe PDF

ET OpenDocument Spreadsheet

Save the workbook in the Open Document

Format,

PDF or XP5
Publish a copy of the workbook as
XPS file,

s—J| Other Formats
Openthe Save As dialog box to sel

all possible file types.

Save the workbook in a binary file format

Excel 2007
|H
ng.
s fully

a PDF or

ect from

2] Excel Options | |

2 Exit Excel

The default is Excel Workbook is a document
with the file extension of .xIsx.

You may choose to save it as an Excel 97-2003
workbook to get a file extension of .xls. Users
with older versions can open this type of
workbook.

Save As also allows you to create a copy of the
workbook (that has already been saved) and
give it a new name.

The Save option in the Office Button menu or
on the Quick Access Toolbar will save in
whatever format is the default.
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When doing a Save As or a Save for the first time (#1 for Save or Save As, #2 for Save) you will see the following dialogue
window:

3. Choose where on EI.,, B8R ) -
your CompUter you Honl 2 sert Page Layout Formulas Data Review View Add-Ins Acrobat
would like to save it i 1 b C Calibri -l - |A A || = =||®-| | Siwrap Text General - iﬁ‘ % ’m
such as My 4 Copy . &
# Formst Painter (B r U -3 A~ |E = =||E iE| dMergeacenter~ | [ § - % o ||%] ;9| Conditional Format  Good
Documents or a folder = _ LRI
Clipboard Fi Font (] Alignment (] Mumber ] Styles
within My Documents. || a7 1
There are several ' A
ways to na.Vlgate your : J:E:ETJL:'Z;YW Save in: |@ Training Examples
Computer as seen in 3 |March s My Recent‘ ln ~SBookS. xlsx 3
#3 4 April Documents W i1 Books, wlsx
) 5 May @Desktop
4. You can create a New e une .
Folder while you are 7 luly 5 pocuments
. My
saving a workbook. S 2 Computer
. 9 |September . W
5. Type your file name. 20 loctober Qe
You can also change 11 |November
. . 12 December
the file type here .|f B 1nuary
you want something 14 |February
other than the default. ig [;"ar_clh
. - pri
6. Click Save to finish. 17 | May 5
18
= File name; Books5. xex ﬂ
20
Save as type: = )y 6
21 YRS MEwcel Workbook (. xlsx) q
22
| e = Ce=Dpe=
Click on Excel Options in the |, —
Office Button menu to 25

change the default file type.
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PRINTING

Just like Saving, you can Print from the menu of the Office Button or from the Quick Access Toolbar. The icon on the Quick
Access Toolbar will send your workbook straight to the printer using whatever defaults have been defined. Click on Print in the
Office Button Menu to change printers or

z properties. Print Preview is always a good idea and
2 sddan| can be accessed from the Office Button or the
and print the document ;_ QUiCk Access Toolbar.
11 Print g Wrap Te;
Select a printer, number of copies, and Aerge 2
7 Open other printing options before printing. E Merge

Send the workbook directly to the default

save X ) :
printer without making changes.

5®e to Office Live 4
Print 3

Print Preview L
Preview and make changes to pages before
printing.

HE,?J Quick Print £
Q

?,/ Prepare 3
a.d Send 3
4 Publish 3
= =
Lot
Close

2] Excel Options | |X Exit Excel




When you choose to Print from the Office Button menu you will be able to select a different printer or change properties:

Home

=N M4 cut
B

Paste

53 Copy

CNCEMERET-TEOL

Insert

- o Format Painte

Clipboard

ft

c27

W00 | = |[h LN | | R

== = =
Blw |k = o

=
Ln

i\
Jamuary
February
March
April

May

June

July

August
September
October
Movember
December
Jamuary
February
March

Page Layout Farmulas Cata Review View

Calilri |11

- | & &[T ==

Printer

Add-Ins

=1 Wrap Text

Mame: E’ﬁ VEPLDOM 1'Dell Color Laser 3010cn ‘ W |

Status:

Type: Dell
Where: Administration
Comment:

er Low
r 3010cn

Print range Copies

® al Mumber of copies:
() Pagefs) From: IZI To: |:|

Print what Ijil Ijgl
() Selection

(¥) Active sheet(s)

|:| Ignore print areas

() Entire workbook

[ ] Print to file

Collate

Acrobat

Gene

=

l [ Cancel
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The default printer can be set by going to Printers and Faxes from the Start Menu:

_W_Sﬂdgu. )

Notepad

=
‘-@ Calculator

The Print Shop 22

e

Microsoft Office Word 2007

Adobe Acrobat 3 Pro

P-touch Editor 5.0

Microsoft Office Publigher
2007

Microsoft Office Jhcel 2007

KR B &

ﬁl@ WinsCP

All Pro

E’ Control Panel

Set Program Access and
Defaults

eﬁz Connect To k
& Printers and Faxes

Shows installed printers and fax printers and helps you add new ones.

@| Log Off |§ Shut Down

ﬁ 9 Microsoft Office O... - E!'J Report.csv [Read-0... E!'J Report (2).csv
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Right c¢click on a printer and click on fASet as Defaul tacheaki nt er o
next to it:

"™ Printers and Faxes

File Edit View Favorites Tools Help

Q Back \) lﬁ; p Search [[“ Folders v

Address |9y Printers and Faxes

Broderbund PDF Converter
2.10d
0

Adobe PDF
a
= Ready

Printer Tasks

- Brother QL-570
i}

Offiine

CutePDF Writer

See Also Dell Laser Printer 1710 on

ASSIST1
0

Dell Color Laser 3010cn on
KPLDOM1
0

|__?j Troubleshoot printing
Q) Get help with printing

HP40 14-5taffBvy on KPLDOM 1 Cperations Color on PAC 156

Other Places

E» Control Panel

% Scanners and Cameras
E] My Documents

@ My Pictures
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Print What?

In Excel you have
several options
when it comes to
printing data from
your file. After
selecting Print
from the Microsoft
Office
Button
menu, the Print
window offers you
choices.

Dn
\ o

=T ¥ Cut *j
=3 C
Paste o e . ) = 8 % ||%:8 ;%8| Conditiona
~ - Format Painter| Printer === Formatting
Clipboard 1 Name: |c—j—ﬁ'-.'-K.F‘LDOM1'-.'\-'-.-'|:|r|rRDDm V| ’ Properties. .. l Mumber o
Al Status: Idle - )
A Type: TOSHIBA 545 1c/453c5eries PSL3 I H |
: Where: WW192, 168, 10, 16\print 5,
ETEL [ Print to fie carsdale | % Bedford | Scarsda
1 B Growth Growth Growth
2 Over 55 Pripteange Copies 126 3% 4%
1 I ——
5 18-22 OPage(s) Eom: | 3] To: | 3] 100 2% 4%
i 1317 108 1% 4%
7 512 Print what B T [calate 134 1% 4%
8 0-5 ) Selection ) Entire workbook @ B 117 1% 4%
g Total %,:we sheet(s) 5838 2% 4%
13 nare ghint areas
12
'113 QK ] [ Cancel ]
1: ! ‘ OBedford 2000 0OScarsdale 2000 o@Bedford2011  oScarsdale 2011 ‘
17
18 - . . . .
19 14000 Active sheet is the default - it will print
33 \ whichever worksheet you are on; if you
LY
5 12000 =T want all of the worksheets, you can
23 =] choose Entire workbook. You can also
> 10000 H] print part of a sheet, or the Selection. This
26 | will print whatever you have highlighted.
o 8000 E| Youalso have the normal option of
29| Population = printing All pages or a Page range.
0 6000 -
kY| —
32 4 -
13 4000 f —
34 3 — u —
35 — |
& 2000 — | | E[
37 " = " |
sz[The "Active sheetﬂ S S S TS, . . ; .
- o Overss 4555 2244 1822 13-17 6-12 0-5
ge Range
41
4 4 » M| Population Change Population Change - Your Turn Population by Race Population by Race - Your Turn Populatio
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PART 217 BEYOND THE BASICS

o g:: Z AutoSum ~ W L_?a
- -

EDITING Insert Delete Fnrmat Sort & Find &
- <2 Clear~ Filter = Select ~

Fill Cells Editing

] o X ” 7 AA Insert Delete F::urmat
When you are entering data Excel can fill in - 4
cells for you with the Fill function to speed Monday __
up the entry if there is some type of pattern 2
that can be repeated. For example if you / X X
type Monday, you can use the Fill function Monday
to fill in the rest of the week for you. Click in Tuesday Series...
the cell that contains Monday; hover over Justify %
the bottom right-hand corner until you get + you can then click and s risene

drag to fill in cells (in any direction) T notice the balloon that pops up /
showing Tuesday. You can see the fill values in the balloon.

Series in Type
{:} Rows {f} Linear
{*) Columns () Growth

On the Home ribbon in the Editing group there is a Fill button 1 if you O Date
need additional options for filling you can use the Series option on the O AutoFil
menu. [Jrend
Step valus: Stop value: I:I
[ OK l [ Cancel ]
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Monday
Tuesday
Wednesday
Thursday
Friday

Saturday
Sunday
Monday
Tuesday
Wednesday

= )

+

b
*
O
-
O

apy Cells

Fill Series

Fill Farmatting Cnly
Fill Without Formatting
Fill Days

Fill Weekdays

Monday
NMonday
Monday
NMonday
Monday

NMonday
Monday
NMonday
Monday
NMonday

2

If the values you are going to be filling can be a
pattern (i.e. Monday i Sunday) but you do not
want that pattern, you can change the values. In
the picture to the left, the days of the week
series was filled down. After the cells have been
filled you can change the value i at the bottom
right-hand corner of the selected cells you will
see a button with an arrow indicating a
dropdown menu. Click on the button 1 Fill
Series is selected i choose Copy Cells instead
and the data you entered will be copied as you
see with the Monday series here.
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) Excel Help
=& QS & AMe |

For more help you
can search the word

series in the Excel ~ P search - |
Excel Home = Worksheet and Excel table basics = Entering and editing data

help. There will be a
link Excel Home > Worksheet Fill data automatically in worksheet cells
and Excel table basics >
Entering and editing data.

Tags fill; formula; paste; repeat; save; tab

There are topics and tips for
filling in data automatically in @it are tags?
Worksheet Ce"S' Instead of entering data manually on a worksheet, you can use the Auto Fill feature to fill cells with data that follows a pattern orthat is based on data in other
multiple worksheets. Forinformation about how to manually enter data, see the article Enter data manually.

What do you want to do?

4 Autormatically repeat values that already are found in the colurmn
¥ Use the fill handle to fill data

< Fill data into adjacent cells by using the Fill command

4 Fill formulas into adjacent cells

% Fillin a series of numbers, dates, or other built-in series items
4 Fill data by using a custom fill series

If the first few characters that you type in a cell match an existing entry in that column, Excel automatically enters the remaining characters far you. Excel autom
that contain only numbers, dates, ortimes are not automatically completed.

After Excel completes what you started typing, do ane of the following:

= To accept a proposed entry, press ENTER.
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Sorting

One of the nice options with Excel is that it is very flexible with arranging the data i the data can be sorted by any of the
columns 1 you can even do secondary sorts (for example, first sort by city, then second sort by last name). To make it the
most flexible each piece of data should be in its own column T such as separating the first name and last name.

Here is a sample worksheet:

A B C D E F ] H |
1 LAST FIRST STREET CITY STATE ZIP PHOME CELL BIRTHDAY
2 Millikan Jennifer |140 E. Jefferson Kirkwood MO 63122 314-555-1234 | 314-555-1252 1/14
3 |Library Lisa 141 E. lefferson Kirkwood MO 63122 314-355-1235 | 314-5355-1253 2/15
4 |Kirkwood |Karen 142 E. lefferson Kirkwood MO 63122 314-555-1236 | 314-355-1254 3/16
5 |Public Patty 143 E. lefferson Kirkwood MO 63122 314-355-1237 | 314-5355-1255 4/17
6 [Millikan Tom 144 E, Jefferson <irkwood MO g3al22 314-555-1238 | 314-555-1256 5/18
7 |Library Luke 145 E. lefferson Kirkwood MO 63122 314-555-1239 | 314-355-1257 6/19
8 Kirkwood |Kyle 146 E. lefferson Kirkwood MO 63122 314-555-1240 | 314-355-1258 7/20
g | Millikan Sarah 147 E. lefferson Kirkwood MO 63122 314-355-1241 | 314-555-1259 1/14
10 |Library Bonnie 143 E. lefferson Kirkwood MO 63122 314-555-1242 | 314-355-1260 2/15
11 [Kirkwood [Melinda 149 E. Jefferson wirkwood  [MO 63122 314-555-1243 | 314-555-1261 3 16
12 |Public Marilyn 150 E. Jefferson <irkwood MO g3al22 314-555-1244 | 314-555-1262 4/17
13 | Millikan Lynn 151 E. lefferson Kirkwood MO 63122 314-355-1245 | 314-5355-1263 5/18
14 |Library Kathy 152 E. Jefferson <irkwood MO g3al22 314-555-1246 | 314-5355-1264 6/19
15 | Millikan Sandy 153 E. lefferson Kirkwood MO 63122 314-355-1247 | 314-5355-1265 1/14
16 |Library Deb 154 E, Jefferson <irkwood MO g3al22 314-555-1248 | 314-555-1266 2/15
17 |Kirkwood  [Amy 155 E. lefferson Kirkwood MO 63122 314-5355-1249 | 314-355-1267 3/1a
18 |Public Julie 156 E. Jefferson <irkwood MO g3al22 314-555-1250 | 314-555-1268 4/17
19 | Millikan Pati 157 E. lefferson Kirkwood MO 63122 314-355-1251 | 314-5355-1269 5/18
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— = x
|@ _ ™1 W
J Z AutosSum T ? 1;?3
Select the column you wish to sort on and then click 3] Fill -
on the Sort & Filter button (Editing group, Home & /3 Clear - E_th‘f 8 'Tdd&
. ilter [
ribbon). A e+
E.‘Ir sort Ato 2
Zl| sortZtoa
Q E Custom 5ort...
o H2-C-S&Q - | V= | Eiter
ﬁ r
—F‘/ Home Insert Page Layout Farmulas Data Review Wiew Add-Ins LA
3 & Cut Calibri -l - A KB ==l | SiwepTex =
53 Copy ;
Pa;ste jF-:urmat Painter 'B I U - E -[| &3~ é ||| = = |=|| == 2E| EHEI’QE B Cent
Clipboard (] Font IF] Alignment ) ) ) )
a1 - ( %] LAST A warning window will ask you to Expand the selection
R rT— s | (that way the entire row of data that belongs to that last
1 LAST Microsoft Office Excel found data next to your selection. Since you have not PHON name moves
2 |millikan 14 selected this data, it will not be sorted. 314-555-1  with it in the A B C
3 |Library LY ‘What do you want to do? 314-555-1 SOI’t) C”Ck on 1 LAST FIRST STREET
4 Kirk'-’_mﬂd K] @ Expand the selection; 314-355-1 Sort and your 2 |Kirkwood |Karen 142 E. lefferson Ki
5 |Public Pl O continue with the current selection 314-555-1 ) rkwood | ) P )
6 [willikan |7 s12.555.1 data will be 3 |Kirkwoo Kyle 146 E. Jefferson Ki
Sl Library L [ sort '\l | cancel 3125551 sorted. 4 Kirkwood |Melinda |143E. Jefferson Ki
8 |Kirkwood |KiTE TS T Te T e ROy n.ng' R 314-555-1 5 Kirkwood |[Amy 135 E. Jefferson K
9 |Millikan Sarah 147 E. Jefferson Kirkwood |MO 63122 314-555-1 & |Library Lisa 141 E. Jefferson Ki
10 |Library Bonnie 148 E. Jefferson Kirkwood |MO 63122 314-555-1 7 Library Luke 145 E. Jaffarson <
11 |Kirkwood ||Melinda |149E. Jefferson Kirkwood |MO 63122 314-355-1 2 |Libra Sonnie 148 £ Jafferson <
12 |Public Marilyn 150 E. lefferson Kirkwood |MO 63122 314-355-1 - v _ - )
13 [millikan  [Lynn 151 E. Jefferson Kirkwood |MO 63122 | 314-555-1 9 Lbrary Kathy 152E. Jefferson <
14 |Library Kathy 152 E. Jefferson Kirkwood |MO 63122 | 314-555-1 10 |Library Deb 154 E. Jefferson Ki
15 |Millikan  |Sandy 153 E. Jefferson Kirkwood  |MO §3122 314-555-1 11 |Millikan Jennifer |140E. Jefferson Ki
16 [Library Deb 154 E. Jefferson Kirkwood  |MO 63122 314-555-1 12 [Millikan Tom 144 E. lefferson Ki
17 |Kirkwood  [|Amy 155 E. Jefferson Kirkwood |MO 63122 314-355-1 13 | Millikan Sarah 147 E. Jeffersan <i
18 |Public Julie 156 E. lefferson Kirkwood |MO 63122 314-555-1 14 | Millik L 151 E._l £ ‘i
19 |Millikan Pati 157 E. lefferson Kirkwood  |MO 63122 314-555-1 TRan ynn - JETTerson :
15 |Millikan Sandy 153 E. Jefferson Ki
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% AutoSum ~ W L_?a
You can use the Custom Sort menu option to choose 3] Fin -
: ; ; Sort & | Find &
secondary sort optlgns. For example in the Ilst_abgnve /2 Clear ~ o er S
the last names are in alpha order, but not the first T so Al sotAtez
Karen Kirkwood comes before Amy Kirkwood. . 1
21| sotztoa |
0 |4 Custom Sort.
] ) ) ] = | Filter
Click on the Add Level button; this will give you the c
option to fAiSort byo and i 7
o
I
3 * cut Calilari -l ~|A AT == %?/“'| = Wrap Text General - ijﬁ‘
=3 Copy Py | i
Paste  Format Painter (B U-[H-|[&- A E = =E|EE| MergeaCenter~ ||| $ - % 2 || %0 5% I'__Coﬂrﬂgfnﬂg
A2
A [ ‘-’;1 Add LEV?{J[ X Delete Level ” 53 Copy Level ” » My data has headers I
1 LAST Colurmn W Sort On Order BIRTHDAY
2 [Millikan Sort by |LA5T v |'-e'alues v| |At02 v| b2 1/14
3 |Uibrary Then by |'-a'alues v| |At02 v| p3 2/15
4 |Kirkwood i 316
5 |Public i) a/17
g |Millikan i 5/18
7 |Library 57 6/19
g |Kirkwood i 7/20
9 |Millikan i) 1/14
10 |Library ok | [ cancel | o 2/15
11 [Kirkwood ™ wennag LA E, TETTersar RITRW OO0 |V D3LLZ S14-203-1.285 | 314-000-1.2b1 3/16
12 |Public Marilyn 150 E. Jefferson Kirkwood |MO 63122 314-555-1244 | 314-555-1262 a/17
13 |Millikan Lynn 151 E. Jefferson Kirkwood |MO 63122 314-555-1245 | 314-555-1263 5/18
14 |Library Kathy 152 E. Jefferson Kirkwood (MO 63122 314-555-1246 | 314-555-1204 8/19
15 [Millikan Sandy 153 E. Jefferson Kirkwood (MO 63122 314-555-1247 | 314-535-1205 1/14
16 |Library Deb 154 E. Jefferson Kirkwood (MO 63122 314-555-1248 | 314-555-1266 2/15
17 |Kirkwood |Amy 155 E. Jefferson Kirkwood |MO 63122 314-555-1249 | 314-555-1267 3/16
13 |Public Julie 156 E. Jefferson Kirkwood (MO 63122 314-555-1250 | 314-555-1268 a/17
19 |Millikan Pati 157 E. Jefferson Kirkwood |MO 63122 314-555-1251 | 314-555-1269 5/18

Choose LAST in the Sort by
field and FIRST in the Then

by field to get:
A B

LAST FIRST 5T
Kirkwood  [Amy 155 E. leff
Zirkwood  |Karen 142 E. leff
<irkwood  |Kyle 145 E. leff
{irkwood |Melinda |149 E. Jeff
Library Bonnie 148 E. Jeff
Library Deb 154 E. Jeff
Library Kathy 153 E. leff
Library Lisa 141 E. Jeff
Library Luke 145 E. leff
Millikan Jennifer |140E. Jeff
Millikan Lynn 151 E. leff
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AutoSum

Excel can be used for a variety of data functions with formulas. One common function is the
AutoSum feature i it can be found in the Editing group on the Home ribbon and in the

¥ AutoSum ¥ ? \_?a

@] Fill -
Sort & Find &
A Clear™  Filter~ Select~
Editing

Function Library group on the Formulas ribbon.

(= o - = ugﬂ a4 )= Program Attendance 2009-2010 for Action Stats.xlsx - Microsoft Excel

"J
il
—/ Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat

o - — - - - — Lo - : Y - i i[5 i3
ﬁ z M @' AJ @ m ~=) Define Name J:ﬂd Trace Precedents ﬁ Show Formulas &j ] if:.j a et [
= S Use in Formula = =T Trace Dependents ‘@ Error Checking = | & |—|

Watch Calculation '-;.,J Calculate Sheet

Insert AutoSum Recently Financial Logical Text Date & Lookup & Math Mare Mame

Function - Used = - - - Time ~ Reference = & Trig* Functions = || Manager B Create from Selection i Remove Arrows ~ () Evaluate Formula | window Optians =
Function Library Defined Mames Formula Auditing Calculation
C26 hd Je | =SUM(C21:C25)
—T =3 Copy & — == =
Paste ) o - - - = [ == == -g__ e & Center = - B =0 .00 | Conditional Format Good
1 H|ghl|ght the cells you wish = < Format Painter | | 3 LR 1l= = ] - | = == || B Merge & center - [ § - % 9 |[T55 5 Formatting = as Table =
' . Clipboard (F] Font IE} Alignment ) Number (F] Styles
tO add and rece|Ve a total C26 - \ f;‘| :SUF\’]I:CZJ.:CZS}
2. Click on the AutoSum A B c D E F G
\ Computer Classes
button 19 Sompuieiases >
. Date Course Mumber of | Placealin Mumber of
3. Notice the formula Participants | this column Staff
:SUM(CZ]_CZS) in the for class to Members AT
. get total {Included in 3] Fin - iy, e
Function/Formula bar classes for Total 2Cear~  Fiters Selecte
4. Cell C26 shows the sum of 1 Lo Barticipasts; ___
' 21 8/13/09 Windows XP \ 11 1 0
C21+C22+C23+C24 + 22|\ s/19/09 Word 1 \ 11 1 2
f20/1 11 \ 9 1 0
025 23 8/20/09 Exce
24 || 8/26/09 Word 2 ¥ 11 1 2
25 8/27/09 Excel 1 4 1
STAFFTOTAL
26 TOTAL PARTICIPANTS & CLASSES = 42 5 2 4 Hough Center
27

36




You can also set the
formula to s
cells so when the data is
entered into the cells the
sum (formula) will already
be there.

Click in the cell you wish to
contain the sum i such as
A9 here.

u

I

SUM (2 X & f| =sum()
A B C D E
1
2
3
a
5
6 : N
- Clipboard P Font
g _suw ~ (0 X v A =sum(a1:Ag]
9 |=sUM() __ B C D E
10 | SUMnumberl, [numberd], ...} | 1 :' .':
11 2 E
12 3 ! !
13 4] E —
5 !
6 ) 5
' |
Then you can highlight the cells you 7 5
want to be included in the sum i in 5 Lfsfu’rﬁﬁ"’{ a
this case Al thru A8. | Sl._Ir-.-l[r'|urnl::lan;l-:‘:l.ic [lr'chII'nhEI'E], ) | A
1 . |
2
3 48
As you enter number into those : :!
cells (and press enter/return) the 6
sum will be calculated. -
8
9 61
10
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Check out

the Help for
more information on
summing.

) Excel Help

(€ (200 %) & M@ @

autosum

| 2 search -

Excel Home = Formals and name basics

Sum the values in cells, columns, or rows

B

547,000
554,000/
584,000

3
“~ =COUNT|B2:D4)

=SUM|D2:B4)

In this article

D

547,000

554,000

84,000

5185,000

4 Simple addition and subtraction

< Dema: Yiew sums by using the Excel status bar
4 Addthe values in a cell by using a simple formula
4 Bubtractthe values in a cell by using a simple formula
4 Addthe values in a column or row by using a button
4 Add the values in a range by using a function
% Subtractthe values in a range by using a function
4 Summing data by grouping and pivoting
+ Addthe values in a column by using an outling
4 Addthe values in a list or Excel tahble column by using a function
< Bum your data and look at it from different perspectives
4+ Summing data based on ane or more conditions
4 Add the values in a range based on a single condition by using a single function or a combination of functions
# Addthe values in a column based on single or multiple conditions by using a function
4 Addthe values in a range based on multiple conditions by using a wizard
+ Addthevalues in arange based on multiple conditions by using a single function or a combination of functions
4 Summing squared and array values
4 Special cases (running total, unique values)
4 Create a running total by using a function
4 Add the unigue values in a range by using a compound formula
4 Including values from other worksheets or workbooks in a formula
4 Summing and subtracting date and time values
4 Displaying calculations on the status bar

Summing (adding values) is an integral part of data analysis, whether you are subtotaling sales in the
sum data.

To help you make the best chaoice, this article pravides a comprehensive summary of methods, suppaon

Summing should not be confused with counting. For more information about counting cells, columns,
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HEADERS

It is helpful to use headers to identify data. There can be both horizontal and vertical headers as you can see here.

D"J = = -~ EBEE s Headers.xls - Microsoft Excel
_h_'!/ Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat
=& cut Calibri 1 | A A= =8| | 5FwWrap Text General = El‘;l : : ‘ MNormal Bad
B . o) = 25"
Pajte # Format Painter ) i s - é TIEEEFEF ﬂrﬂerge = center $ - % |58 58 IEJ::rI'llldaltttllingal' a:?’ggla‘:' Good Hewtrs
Clipboard IF] Font IF] Alignment IF] Mumber F] Styles
Y44 - 5 | Tuesday
A B £ D E
1 | e (HGRIZGNTAL HEADER }LABELS DATA IN COLUMMNS 'HEADER COLUMN C HEADER COLUMM D ETC.
2(VERTICAI. HEADER)_ABELS DATA IN ROWS 123|Monday January
3 Banana 436|Tuesday February
4 HEADER ROW 4 Cat 783 | Wednesday March
5 HEADER ROW 5 Dog 1122|Thursday April
& ETC. Egg 1455 |Friday May
7 |EILC. Food 1788 |Saturday June
8 ETC. Guitar 2121|Sunday July
9 |ETC. Hat 2454 |Monday August
10 |ETC. lgloo 2787|Tuesday September
11 |ETC. Jump Rope 3120\ Wednesday October
12 ETC. P |cite 3453 |Thursday November
13 |ENLC. Lion 3786 |Friday December
14 |ETC. NMoon 4119|Saturday January
15 ETC. Nightlight 4452|Sunday February
16 |ETC. Opera 4785|Monday March
17 |ETC. Park 5118|Tuesday April
18 ETC. Quail 5451 | Wednesday May
19 ETC. M Ribbon 5784 | Thursday June
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When the spreadsheet contains a lot of data where all of the rows and columns cannot be displayed you will have to scroll

and when you scroll down and over you can no longer see the headers which may make reading/interpreting the data difficult

not knowing what it is.

Y44 S | Tuesday

D E F
10 |Igloo 2787|Tuesday September September
11 |Jump Rope 3120|Wednesday October October
12 Kite 3453|Thursday Movember Movember
13 |Lion 3786|Friday December December
14 \Moon 4119(Saturday January January
15 |Mightlight 4452 (Sunday February February
16 Opera 4735 (Monday March March
17 |Park 5118|Tuesday April April
18 |Quail 3451 |Wednesday May May
19 |Ribbon 5784|Thursday June June
20 |Statue 6117|Friday July July
21 |Tape 5450|Saturday August August
22 |Unicorn 6783 |5unday September September
23 |Wacuum 7116|Monday October October
24 'Woman 7449|Tuesday Movember Movember
25 |¥-Ray 7782|\Wednesday December December
26 |Yam 8115|Thursday January January
27 Zebra 8448|Friday February February
28 |Apple 8781|5aturday March March
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You can freeze the header row and column so they stay on the screen even when you scroll. On the View ribbon there is a
Freeze Panes button i the menu you get when clicking on it allows you to freeze the first row and freeze the first column.

A

A

To lock rows, select the row below the row or rows that you want to keep visible when you scroll.

To lock columns, select the column to the right of the column or columns that you want to keep visible when you

scroll.

To lock both rows and columns, click the cell below and to the right of the rows and columns that you want to keep

visible when you scroll.

E;ﬂ = 9~ EB&E s Headers.xls - Microsoft Excel
_%/ Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat
| El | ‘ ]']'J J - K F':'r""l-"a fax "‘;I 73 J = % 3 view Side by S-ide % ]
¥ Gridlines W| Headings i — = ]
Mormal| Page Page Break | Custom  Full Zoom 100% Zoomto Mew  Arrange Save Sv
Layout  Preview Views Screen =L Selection || Window All Waorkspace Win
Workbook Views Show/Hide Zoom ) ufreeze Panes
va4 M fe | Tuesday = Ee e
A B Freeze Top Row
1 e e - LS O e G LSS U T
2 VERTICAL HEADER - LABELS DATA IN ROWS |Apple Freeze First Column
3 HEADERROW 2 Banana :l_| Keep the first column visible while scrolling
through the rest of the worksheet,
4 HEADER ROW 4 Cat OITYVECTIE SOy TTETGTT
5 HEADER ROW 5 Dog 1122 |Thursday April
& ETC. Egg 1455|Friday May
7 EIC. Food 1788 |Saturday June
8 ETC. Guitar 2121 |Sunday July
9 |ETC. Hat 2454\ Monday August
10 |ETC. lgloo 2787 |Tuesday September
11 ETC. Jump Rope 3120|Wednesday October
12 ETC. Kite 3453|Thursday Movember
13 ETC. Lion 378a|Friday December
14 ETC. Moon 4119|Saturday January
15 |ETC. Nightlight 4452|Sunday February
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181

Here you can still see Row 1 and
Column A (the headers) since the

headers have been frozen.

42



CHARTS

Data in Excel can be selected and easily turned into a chart. Simply highlight/select the data (include the headers) and then
click on the type of chart you want on the Insert ribbon.

,.fﬁ;\ = - - @ &) Data for Charts.xls [Compatibility Mode] - Microsoft Excel
G |
. Home Insert Page Layout Farmulas Data Review View Add-Ins Acrobat
e e e | =
i) e | el B8 = | o Al 2 4 -
i el p e & A 5 A &
PivotTable Table Picture Clip Shapes Smartart || Colu Line Pie Bar Area Scatter Other Hyperlink Text  Header WordArt Signature Object Symbol
- Art - "% - - ~ - - Charts = Box & Footer - Line =
Tables INustrations Charts F] Links Text
Al - J |
A B G D E F G H | J
# Bedford # Scarsdale | % Bedford |% Scarsdale

1 Bedford 2000 | Scarsdale 2000 | Bedford 2011 Scarsdale 2011 Growth Growth Growth Growth

2 Over 55 6000 3150 6180 3276 180 126 3% 4%

3 45-55 12000 3150 12300 3276 300 126 2% 4%

4 2244 7500 3150 7650 3276 150 126 2% 4%

5 18-22 1200 2520 1224 2620 24 100 2% 4%

b 1317 1500 2730 1522 2839 22 109 1% 4%

T 6-12 1200 3360 1218 3494 18 134 1% 4%

a 0-5 600 2940 609 3057 9 117 1% 4%

9 Total 30000 21000 30703 213838 703 a3a 2% 4%

40
Once you have a chart, you will also have Chart Tools i the Design, Layout and Format ribbons.

!-/63-3\\ = = @ & )= Data for Charts.xls [Compatibility Mode] - Microsoft Excel Chart Taols

:j/ Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat Design Layout Format

= E=zz]

i W, A T (== i - | (]
Change  Save As Switch Select Jﬂlij —Du—l-lﬁ— ﬂu___.IIJF_ _ I I I I i i i I I i i I I _ Mave
Chart Type Template || Row/Column Data - - Chart

Type Data Chart Layouts Chart Styles Location
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A B C D E F G H |
# Bedford # Scarsdale | % Bedford (% Scarsdale
1 Bedford 2000 Scarsdale 2000 Bedford 2011 Scarsdale 2011 Growth Growth Growth Growth
2 Over 55 G000 3150 G130 3276 180 126 3% 4%
3 45-55 12000 3150 12300 3276 300 126 2% 4%
4 22-44 7500 3150 7650 3276 150 126 2% 4%
5 18-22 1200 2520 1224 2620 24 100 2% 4%
] 1317 1500 2730 16522 2839 22 109 1% 4%
7 6-12 1200 3360 1214 3494 18 134 1% 4%
a 0-5 600 2940 509 3057 9 117 1% 4%
9 Total 30000 21000 30703 21838 703 a3d 2% 4%
10
11 35000
12
13 30000 -
14
15 25000 —
16
17 200040
18 . W Bedford 2000
Population

13 15000 M Scarsdale 2000
20
2 Bedford 2011

10000
22 M Scarsdale 2011
23

5000 A
24
25
26 o
27 Owver55 45-55 22-44 18-22 13-17 6-12 0-5 Tatal
28 Ape Range
29
30
31
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You can select the
chart and then use the
chart tools to format it
as you like 1 two
clicks here and it
looks completely
different.

Look in

the Help for more tips!
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